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Copyright
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1 System description
The BigFarmNet Manager is the central program for all BigFarmNet applications. The 

software is a modern Windows application for all-in-one management of a farm. The 

system runs as a standard on a wide variety of Big Dutchman control computers, but 

also on any Windows PC.

1.1 System requirements

Supported operating systems

Windows 10 / Windows 8.1 / Windows 8 / Windows 7 / Windows Server 2012 R2 / 

Windows Server 2012 (64-bit edition), Windows Server 2008 R2 SP1

Other system requirements

• Microsoft.NET Framework 4.0: version 4.6.1

• Processor: Intel Core i3 or equivalent 

• RAM: 8 GB

• Hard drive: 32 GB free storage

• Monitor:

–  1280 x 1024 (minimum)

–  1920 x 1080, high color, 32 bits (recommended)

• USB interface

1.2 Software version

Software version 3.3
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2 Installing the software
To install the BigFarmNet Manager, it is necessary to first execute the BigFarmNet 

setup.

NOTICE!

Your PC may display security alerts during installation of the software. Confirm these 

alerts to continue the installation process.

1. Insert the supplied USB flash drive into the USB port of the computer on which you 

want to install BigFarmNet Manager.

2. Start the installation by double-clicking on the file BigFarmNet-BDPig-Setup.

This opens the setup wizard, which will guide you through the installation process 

step by step.

3. Follow the instructions of the setup wizard until installation is complete.
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3 Initial program start
After installation has been completed, the BigFarmNet Manager icon is displayed on 

the desktop.

1. Start the program by double-clicking on the icon.

BigFarmNet Manager

2. Enter the following user data and click on "Log in".

User name: admin

Password: 1234

The BigFarmNet Manager starts now. For the initial program start, the language is 

set to English.
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Page 4 Initial program start
3. Select the correct network card.

This prompt comes up once, directly after initial program start. 

The network card guarantees connection with the corresponding control 

computer(s) for data exchange, among other functions.

4. To set the correct language for the user interface, create a user with this language:

a) In the "Manager" menu, click on "User management".
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b) Create a user with administrator rights by copying the "admin" user.

c) Enter a user name and select the correct language.

d) Confirm your inputs by clicking on "OK".

e) Close and restart BigFarmNet Manager.

f) Log in as the new user (without entering a password). 

BigFarmNet Manager opens with the correct language.
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4 User management
Create users and assign them specific rights in the user management. The user 

settings are loaded upon login.

4.1 Creating a user

1. In the "Manager" menu, click on "User management".

2. Click on "Add".

OR

Copy an existing user if you want to create a user with the same settings.

a) Select the user you want to copy.

b) Click on "Copy".

3. Define the following settings under "General":

– Language of the user interface

– Unit system
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– User group:

Admin: full rights for settings, user management, etc.

Normal: limited rights for settings; password change possible

Guest: read-only rights

4. Under "Rights", determine to which settings and views the user shall have access.

Checked boxes  indicate that access is permitted.

5. Click on "OK" after you have configured all settings.
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4.2 Changing the password

You can change existing passwords or assign passwords only for users of the "Normal" 

and "Admin" user groups. 

When you enter a password for the very first time, the field "Old Password" remains 

empty. 

NOTICE!

The password must consist of at least 6 numbers. Using combinations of numbers such 

as 123456 or 333333 as well as letters is not possible! 

Users belonging to the "Guest" group cannot create or change passwords. The 

following message is displayed if they try:
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5 Automatic logoff
The automatic logoff is a safety function that can be adjusted as required.

The user is automatically logged out if he or she has not been active for a specific time. 

This time can be set in the menu "Manager" > "General settings".

If the time is set to 0, automatic logoff is disabled. In the pre-settings, automatic logoff 

is disabled.
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6 User interface

6.1 Structure

Title bar

Menu bar with additional submenus and functions 

Toolbars

Farm structure, depicted as tree structure

Application window 

Status bar 
Installation/Configuration
Edition: 06/19      99-97-4231 GB          



User interface  Page 11
6.2 Toolbar

In addition to standard functions, the toolbars also show functions that belong to an 

application (license) and that only appear after its installation. 

Icon Description Explanation

Overview of the farm View of the entire farm 

Survey

Overview of the climate data for the different 

areas of the house, including selected key values 

and production data 

Pig Manager Management of pigs 

Sow Manager Management of sows

Silo Manager Management of silos

Task Manager Timetables for control tasks, e.g. feeding

TriSort overview Overview of all installed TriSort systems

CallMatic overview Overview of all installed CallMatic systems

History History of the climate data in curves 

Climate
Graphic overview of current climate data and 

setting of parameters for climate control

Batch Manager

View and management of activities in connection 

with climate control, like moving pigs in or out and 

house cleaning

Remote control

Adjustment of climate programs which regulate 

ventilation, heating, temperature, humidity and 

pressure control over a fixed period of time

Alarm log Errors (warnings and alarms)

Network management Management of the own and foreign systems
Installation/Configuration
Edition: 06/19     99-97-4231 GB 



Page 12 User interface
6.2.1 Adding menu points to the toolbar

Menu points can now be copied from the menu structure and added to the toolbar for 

quick access.

The following instructions explain how to add the menu point "Feed curves" to the 

toolbar as an example.

1. Open the menu structure until you reach the correct menu point.

2. Press Ctrl + Alt and hold these keys.

3. Left-click on the menu point and hold the mouse button.

The menu structure closes and a small icon appears at the mouse pointer.

4. Release the key combination but continue holding the left mouse button.

5. Drag the mouse pointer with the icon to the desired position in the toolbar.

If the selected position is possible, a black line will appear.

-
Expand / collapse the pane showing the farm 

structure

- Stop the equipment

-

Undock the "Equipment" window

This function appears after selection of the 

system in the farm structure.

Icon Description Explanation
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6. Release the left mouse button.

The icon of the desired menu point now appears in the toolbar.

6.3 Farm structure

The farm structure shows a tree structure of your farm as 

you have created it in the Configurator, see chapter 7.

Using the farm structure, you can quickly navigate to your 

systems or view selected information regarding different 

locations, see chapter 6.4.

The farm structure also shows which location has an error. 

The alarm icon  or the warning icon  appear at this 

location, depending on the error. Click on the respective 

icon to switch directly to the alarm log.

Click on the sow icon  to switch directly to the Sow 

Manager.

Click on the pig icon  to switch directly to the Pig 

Manager.

Click on the correct controller icon  to switch to the 

required system.
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In the view "Overview of the farm" , the 3D image or the photo of your farm will 

appear if you have created it in the Farm Designer, see chapter 8.

Clicking on a section in the farm structure highlights the corresponding part of the 

building in the application window. Vice versa, clicking on a building or part of a building 

in the application window highlights the corresponding location in the farm structure.

The same applies to the climate computer. If you click on a climate computer in the farm 

structure, the section in which this climate computer controls the climate is highlighted.
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6.4 Key values

A small window next to each house and each selected area/section displays the 

corresponding data, the so-called key values. Select the key values you want to see.

1. In the farm structure, click on the house or section/area whose key values you wish 

to change. 

2. Right-click into the window showing the house's or section's key values.

3. Click on "Show KeyValue selector...".
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4. Open the list of all available key values by clicking on the plus icons in the left-hand 

window. 

Climate key values are only displayed for sections in which a climate computer is 

installed. Check the box "Show advanced key values" to be able to select more key 

values.
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5. Double-click on the key value to transfer it to the field "Selected key values" or click 

on the arrow pointing to the right.

OR

Double-click on the key value to remove it from the field "Selected key values" or 

click on the arrow pointing to the left.

6. Click on "OK" to accept this selection.
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7 Creating the farm structure
The farm structure depends on the system whose application you add later on. Specific 

information regarding the farm structure and the addition of system applications is 

available in the manual for the respective system application.

Create a farm structure consisting of houses, sections and pens as follows:

1. Click on "Configurator" in the "Setup" menu.

2. Create the farm structure under the first tab, "Locations and network controllers".

The farm structure is displayed on the left in the Farm overview. The lower part of 

the window shows the tools necessary for creating the structure. The buttons for 

lower levels, such as sections and pens, will only appear after the superior level 

has been created.

In the upper part of the window, under Location, you may enter a name for the 

objects. The name is passed on to the next added objects of the same level. This 

means that if you leave "House" as the name, all other added houses will also be 

called "House". The objects are numbered consecutively.
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NOTICE!

Pens often equal valves. Refer to the configuration specified in the house plan 

when adding and naming pens. For further information, check the manual for the 

respective system application. 

3. Save your settings by clicking on "Save" and confirm the next dialogs with "OK".

Icon Explanation

Add a house

Remove a house

Add a section

Remove a section

Add a pen

Add 5 pens simultaneously

Remove a pen

Change the object's position in the structure
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8 Depicting a farm in the Farm Designer
The Farm Designer provides you with two options for creating a three-dimensional 

depiction of your farm. This requires that the farm structure has been created 

beforehand, see chapter 7.

• Creating a 3D image based on the created houses.

• Uploading a photo (aerial shot) of your own farm in the mode "Foto Farm" and 

using it as background image. The houses' sections in the photo are retraced for a 

graphic display.

After closing the Farm Designer, the completed depiction appears in the "View" 

window.

Start the Farm Designer by clicking on "Start Farm Designer" in the application window.

The new window automatically opens the edit mode for the 3D image.

1. "Other Objects" are streets, other buildings, silos, etc.
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2. "Existing Objects" are houses of the created farm structure.

3. Tools to edit the farm depiction, see chapter 8.1.

4. Camera icons to save different views of the house, see chapter 8.3.

8.1 Tool bar

Icon Description Explanation

Farm view Standard position / complete view of the farm

Bird's eye view Switch view to bird's eye view

Grid Hide / show grid lines

Perspective Create a three-dimensional view

Zoom in / zoom out Zooming into / out of the view

Description boxes 

(labels)

Hide / show description boxes of individual 

houses and sections 

Selection tool
Select objects (draw a rectangle over the 

objects while holding the left mouse button)

Camera Create and save a specific view

Undo / redo Undo / redo an action 
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8.2 Configuring the grid

If you want to align the 3D image based on a grid, click on . Adjust the size of the 

grid as follows, if necessary:

1. Click on "Grid settings" in the "View" menu.

2. Enter the correct values into the input fields or change them using the arrows 

pointing upwards and downwards. 

3. Accept these inputs by clicking on "OK".

8.3 Adjusting and saving views

As soon as you have created the 3D image or edited the uploaded photo, you may save 

different views.

1. In the toolbar, click on the camera. 

This adds a camera icon to the mouse pointer.

2. Adjust the view as required:

– Zooming in and out: 

Roll the scroll wheel of your mouse.

– Moving to the left and to the right:

Hold down the Control (Ctrl) key and roll the scroll wheel of your mouse.

– Moving up and down:

Hold down the Shift key  while rolling the scroll wheel of your mouse.
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– Turning and changing the perspective:

Left-click into a free drawing pane and hold the mouse button. Move the mouse 

to turn the view and to change the perspective.

3. Save the desired view by clicking on the arrow pointing downwards next to one of 

the camera icons. 

4. Click on "Current view" in the context menu. The view is now saved.

5. If you would like to retrieve the saved view later on, left-click on the corresponding 

camera icon. 
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8.4 Creating a 3D image

8.4.1 Adding objects to the farm design

1. Left-click on the desired object under either "Existing Objects" or "Other Objects" 

and hold the mouse button.

2. Drag the object to the required position in the drawing pane and release the mouse 

button.

The house is shown from above (top view) and the separation into sections is 

visible. Additionally, the distance between the coordinate origin and the house is 

indicated.

8.4.2 Changing the object's size and position using the mouse

A selected object is displayed with arrows and a rotation handle, which you can use to 

modify the object, see also chapter 8.4.8 ”Changing object attributes”.
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• Moving the object:

Click on the object and drag it to the required position while holding the mouse 

button.

• Changing the object's size:

Click on the correct arrow and hold the mouse button while dragging to change the 

object's size.

• Rotating the object:

Click on the rotation handle and move the object around its own axis while holding 

the mouse button.

8.4.3 Changing the object's position using the coordinate

1. Click on the object whose position you wish to change.

2. Change the values under "Position/Rotation" by entering new values directly into 

the input fields X and/or Y or by using the arrows pointing upwards and downwards.

3. Confirm the input by pressing the Enter key. 

The object's position is changed in relation to the X and/or Y axis.
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8.4.4 Freely rotating an object

1. Click on the object you wish to rotate.

2. In the "Reference Point" window, click on the point around which you want to rotate 

the object.

3. Change the value under "Position/Rotation" either by entering the new value 

directly into the input field "Rotation", or by using the arrows pointing upwards and 

downwards.

4. Confirm the input by pressing the Enter key.

8.4.5 Rotating an object by 90°

1. Click on the object you wish to rotate.

2. In the "Reference Point" window, click on the point around which you want to rotate 

the object.
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3. Click on  in the "Position/Rotation" window to rotate the object by 90° to the left.

Or:

Click on  to rotate the object by 90° to the right.

8.4.6 Rotating an object back to its original position

1. Click on the object you wish to rotate.

2. Click on  in the "Position/Rotation" window to rotate the object in its original 

direction.

8.4.7 Defining a reference object 

You may define an object as reference object. All new objects are then added to the 

grid in relation to this object and its reference point.

1. Click on the object you want to use as reference for other objects.

2. In the window "Reference Point", select a reference point for all further added 

objects.

3. Check the box next to "Reference Object".
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8.4.8 Changing object attributes

In the "Object Attributes" window, you can change the individual characteristics of a 

house, e.g. its width and length, the colour of the roof or the height of the ridge. You 

may also change the height and diameter of silos.

8.4.9 Removing an object

1. Click on the object you wish to remove from the drawing pane.

2. Press the Delete key.

8.5 Uploading a photo

1. Click on "Foto Farm" in the "View" menu.

The Farm Designer opens the edit mode "Foto Farm".
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2. Click on "Open image" in the "File" menu.

3. Load the photo into the Farm Designer.

4. Reproduce the created farm structure in the photo:

a) Click on the desired object (house) under "Existing Objects" and hold the 

mouse button.

b) Move the object to the required position and release the mouse button.

You may also move the object later on. The object indicates the number of 

created sections.
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c) Use the circles to drag the object structure as required.

The object structure has info boxes called "labels". These boxes can be 

moved, even later on in the BigFarmNet Manager's application window.
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9 Installing a license from a USB memory stick
1. Insert the USB memory stick into the USB port of the BigFarmNet computer.

2. Click on "Licenses" in the "Setup" menu. 

3. Click on the button "Install or request new licenses".
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4. Click on "Next" in the "Install License Wizard" window. 

5. Select the option indicated below and click on "Next".
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6. Select the option indicated below and click on "Next".

7. Click on the button with the three dots to view the files on the USB memory stick.

8. Select the file "BFNLicenseFile.lic" and click on "Open".
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9. Click on "Next".
Installation/Configuration
Edition: 06/19      99-97-4231 GB          



Installing a license from a USB memory stick  Page 35
10. Click on "Install".

11. Click on "Finish".
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12. A message now asks the user to close BigFarmNet Manager so the license 

settings can be applied. The installed licenses are indicated as active in the license 

dialog.

Confirm the restart dialog. 

13. Start the BigFarmNet Manager again.
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10 Web Access and BigFarmNet App Pig
Web Access allows you to access the data on the BigFarmNet PC from remote with a 

mobile device (smartphone or tablet) for a quick and safe data exchange between the 

mobile device and the farm. 

The corresponding BigFarmNet App Pig can be used both on Android and on Apple 

iOS devices.

A separate license is required for the installation of Web Access.

 

Requirements for executing Web Access:

• installed BigFarmNet Manager software (version 2.5 or higher);

• working internet connection.

You may activate two types of access in the Web Access dialog: 

• access within the local network, exclusively via WLAN;

• access from outside of the local network via the mobile network using FarmLink (if 

necessary additionally with WLAN access).

Security settings are also configured in the Web Access dialog. For example, each user 

can be assigned access rights, provided they have a password, see chapter 4.2.

NOTICE!

The system address for access via the mobile network using FarmLink has changed 

with BigFarmNet version 3.1.

• Previously: farmlink.bigdutchman.com

• Now: bigfarmlink.com

Change the system address in the app when you upgrade to version 3.1. Depending 

on your mobile device, proceed as described in the corresponding chapter:

• 10.3 ”Setting up WLAN and mobile access for an iOS device”

• 10.2 ”Setting up WLAN and mobile access for an Android device”

 Select the system that has already been created.

Code no. Description

91-02-6564 License BigFarmNet – Web Access Pig
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10.1 Configuring Web Access in the BigFarmNet Manager

1. Click on "Web Access" in the "Setup" menu.

2. Click on "Setup Web Access...".

This opens another Web Access dialog.
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3. In the upper part under "Web Access server settings", select a port for access via 

the local network (WLAN). The BigFarmNet App Pig will use this access to create 

the connection.

You may use the standard port recommended by the system or specify an 

individual port. 

4. If necessary, set up access outside of the local network via the mobile network

additionally in the middle of the window. 
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a) Check the box "Enable Web Access via mobile broadband".

b) Define a farm ID.

You may either use the standard ID provided by the system or enter an 

individual ID.

c) Select a server address for FarmLink.

We recommend using the standard server address provided by the system. 

You may also specify a new address.

5. If you have not yet installed the Web Access license, click on the button "Open 

license overview" in the lower part of the window. For further information, see 

chapter 9.

6. Click on "Save" to save all settings.

7. Click on the "User rights" tab in the dialog window. 

All users you have created with the user management are listed here. Users 

without password are inactive. A password is required for Web Access, see chapter 

4.2. 

8. Assign one of the following access rights to each user: 
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– None: The user has no access rights.

– Read: The user has read access only. 

– Read & Write: The user has read and write access.

9. Click on "Save" to save all settings.

10. Click on "Close" to return to the first Web Access dialog window.

This window now shows the system addresses for the specific access types. 

11. Keep the Web Access dialog window with the system addresses open. 

You will need the system addresses to configure the access in the BigFarmNet Pig 

App on your mobile device.
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10.2 Setting up WLAN and mobile access for an Android device

The following instructions show how to set up remote access with an Android tablet. 

The instructions also apply to Android mobile phones. 

You can set up both access types, WLAN and WLAN with mobile access, in the 

BigFarmNet App Pig. The following instructions are applicable for setting up both 

access types. 

1. Download the BigFarmNet App Pig (hereinafter referred to as "app" only) from the 

Play Store.

2. Start the app.

3. Tap on "System" to see a list of all available systems. 

4. Tap on the plus icon to create a new system.
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5. Enter your favoured name of the system under "Name". 

The name should indicate the access type you want to use with the app:

– e.g. WebAccess (WLAN) for WLAN access

or

– e.g. FarmLink (WLAN + Mobile) for WLAN and mobile access 

6. Enter the correct system address under "Address".

You will find the system address under "Setup" > "Web Access".

– WLAN access = system address for access only within the local network 

– WLAN and mobile access = system address for access via FarmLink
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7. Activate the setting "Save Authentication", as required, by checking the box. 

This stores the user name and the password for this access type. You will not have 

to enter the user name and the password again when logging in the next time.

8. Enter the user name and the password. 

NOTICE!

The user name and the password are the same as when logging into BigFarmNet 

Manager.
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9. Tap on the floppy disk icon to save the system in the app and to return to the list of 

systems.

The created system now appears in the list of systems.
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10.3 Setting up WLAN and mobile access for an iOS device

The following instructions show how to set up remote access with an iPhone. The 

instructions are also applicable for iPads. 

You can set up both access types, WLAN and WLAN with mobile access, one after 

another in the BigFarmNet App Pig. The following instructions are applicable for setting 

up both access types. 

1. Download the BigFarmNet App Pig (hereinafter referred to as "app" only) from the 

App Store.

2. Start the app.

3. Tap on "System" to see a list of all available systems. 

4. Tap on the plus icon to create a new system.
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5. Enter your favoured name of the system under "Name". 

The name should indicate the access type you want to use with the app:

– e.g. WebAccess (WLAN) for WLAN access

or

– e.g. FarmLink (WLAN + Mobile) for WLAN and mobile access 

6. Enter the correct system address under "Address".

You will find the system address under "Setup" > "Web Access".

– WLAN access = system address for access only within the local network 

– WLAN and mobile access = system address for access via FarmLink
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7. Activate the setting "Save Authentication", as required, by moving the slider control 

to the right. 

This saves the user name and the password for this access type. You will not have 

to enter the user name and the password again when logging in the next time.

8. Enter the user name and the password. 

NOTICE!

The user name and the password are the same as when logging into BigFarmNet 

Manager.
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9. Tap on "Done" to save the system in the app and to return to the list of systems.

The created system now appears in the list of systems.
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10.4 First app log-in and authorization of the mobile device 

These instructions are valid both for iOS and Android devices. The examples show an 

iPhone and an Android tablet. 

1. Start the app on your mobile device.

2. Tap on "System".

3. Select the system you want to use to log in:

– WebAccess (WLAN) = exclusively internal network

– FarmLink (WLAN + Mobile) = internal network and mobile network

4. iOS device: Tap on "Login" to return to the login.

Android device: Tap on the arrow "Back" to return to the login. 

iPhone

Android tablet

iPhone

Android tablet
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5. Tap on "Login".

If you saved the user name and the password while setting up the system, the 

corresponding information is transferred automatically. If you did not save the login 

details, enter them now. 

NOTICE!

The user name and the password are the same as when logging into BigFarmNet 

Manager.

6. Confirm the next message with "Yes" to accept the Terms and Conditions and the 

Privacy Policy.

NOTICE!

When first trying to log in, a message regarding pending device authorization is 

issued. BigFarmNet Manager generates a warning at the same time.

7. During the first login attempt, the device was connected with the BigFarmNet 

Manager via the system address. 

Authorize the connected mobile device for remote access in the first Web Access 

dialog window ("Setup" > "Web Access") as follows:

iPhone

Android tablet
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a) Check the box in the column "Web Access authorized" to allow remote access 

of the specific mobile device.

In this list, you can manage all connected mobile devices later on:

– Activate or deactivate authorization using the check box. 

– Delete mobile devices by clicking on . 

b) Click on "Save" to accept these settings.

8. Click on "Close" after you have configured and saved all settings in the Web 

Access dialog window. 

9. Log into the app again.

Your mobile device is connected with the BigFarmNet PC after successful setup of 

remote access via Web Access. 
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10.5 Disabling Web Access

The Web Access dialog offers the additional security setting "Disable Web Access". If 

this function is active, all data connections between the mobile devices and the 

BigFarmNet Manager are interrupted.   

1. Click on "Web Access" in the "Setup" menu.

2. Check the box "Disable Web Access" in the upper part of the dialog window. 

3. Click on "Save" to accept this setting.

All data connections between the mobile devices and the BigFarmNet Manager are 

now interrupted.
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11 Separation of business units
In BigFarmNet Manager, it is possible to divide the farm into separate legal business 

units and to write delivery notes from one unit to the other. Invoices can be created via 

Excel data export. Users can be assigned different access rights for individual business 

units of the farm.

This function is relevant for Germany only and requires a license.

1. Create the separate business units in the menu "Setup" > "Business units".

2. Assign the locations of your farm to the business units in the menu "Setup" > 

"Business unit assignments" > "Locations".

Code no. Description

91-02-6615 License BigFarmNet Manager – separation of business units
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3. Also assign the applications to the business units.

4. Assign the correct access rights to the different users: 

a) In the "Manager" menu, click on "User management". 

b) Select the user and click on "Edit".

c) Click on the tab "Rights" > "Business units".
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